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2    LICENSE AGREEMENT

LICENSE AGREEMENT

Wordcraft International Limited

Unimessage Pro Software Licence Agreement

CONDITIONS OF PURCHASE

Software is licensed subject to the limitations on permitted use. No refund will be given after the purchaser 
has installed the software. This Licence shall continue for as long as the Product is in use. Failure to comply 
with the terms and conditions detailed below will result in termination of the licence. All copies of the soft-
ware must be destroyed on termination of the licence.

PERMITTED USES

The original purchaser may use the software on a computer system owned or used by the original purchaser 
for the purpose of any business or profession. The original purchaser may store the software on a hard disk 
system for use only by the permitted number of users and connected only to the permitted number of com-
munication devices as specified in the system configuration file contained within the software product at the 
time of purchase, plus the number of users and devices added by obtaining a valid licensed upgrade from 
Wordcraft International Limited or an authorised agent of Wordcraft International Limited.

USES NOT PERMITTED

1. Downloading of the software from a computer service or bulletin board or use in a multi-site arrange-
ment except in respect of users licensed by Wordcraft International Limited to do so.

2. Use of the software in a computer service business, network, time-sharing, interactive cable television or 
multiple CPU arrangement except in respect of users licensed by Wordcraft International Limited to do 
so.

3. The use of a single user version on a second or subsequent computer or network workstation. Details of 
multi-user packs are available from authorised dealers or authorised distributors of Wordcraft Interna-
tional Limited or direct from Wordcraft International Limited.

4. The use of a network version on a second or subsequent network.
5. The making of alterations and modifications to the software, merging all or any part of the software with 

another program, reverse engineering, decamping, or disassembling of the software.
6. Obscuring any areas of the software responsible for company branding, image, help system, contacting 

Wordcraft International Ltd, identifying Wordcraft International Ltd as the copyright and trademark 
owner, or any such related areas. Exemptions to this clause will only be granted in exceptional circum-
stances at the discretion of Wordcraft International Ltd Applications must be made in writing to Wordcraft 
International Ltd.

7. The right to rent, assign, lease, transfer or grant sub-licences or other rights to others.
8. The making of copies of any documentation belonging to Wordcraft International Limited.
9. The selling or transferring of software marked ‘Not for Resale’ or ‘Evaluation’ or ‘Demonstration’ or 

‘Training’.
10. Any other uses not included in “Permitted Uses” above, which would require a licence to use the copy-

right in the software.
The license contained in this agreement will terminate automatically and without notice from Wordcraft Inter-
national Limited if any provision in this agreement is not complied with.

GOVERNING LAW

This agreement shall be governed by the laws of the United Kingdom of Great Britain and Northern Ireland.
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LIMITED WARRANTY

Wordcraft International Limited make no representations or warranties, express or implied, of any kind with 
respect to the contents of this package and specifically disclaim any express or implied warranty of mer-
chantability or fitness for any particular purpose. Wordcraft International Limited’s liability shall be limited to 
replacing any faulty product with alternative product or a cash refund up to but not exceeding the value of 
the monies paid for the product when originally purchased. In no event shall Wordcraft International Limited 
or their suppliers be liable for any special, incidental, indirect or consequential damages whatsoever (includ-
ing, without limitation, damages for loss of revenue or profits, business interruption, lost or damaged data, or 
any other loss arising out of the installation of, use of or inability to use this software product). Wordcraft 
International Limited shall not be responsible for any claims arising from the use of software marked ‘Not for 
Resale’ or ‘Evaluation’ or ‘Demonstration’ or ‘Training’.
Wordcraft International Limited shall not be responsible for any claims arising from the use of software other 
than the use for which it was specifically sold.
Wordcraft International Limited shall not be responsible for any claims by a third party.
No oral or written information or advice given to Wordcraft International Limited, or given by Wordcraft Inter-
national Limited, or an authorised representative shall create a warranty or in any way increase the scope of 
this warranty.

COPYRIGHT

Software and documentation produced by Wordcraft International Limited is protected by International 
Copyright Conventions.

TRADEMARKS

Wordcraft is a trademark of Wordcraft International Limited.
All other trademarks are acknowledged.
Following installation the package will be automatically registered.
This is a legally binding agreement with Wordcraft International Limited.

If you feel you cannot accept the conditions defined above please return the complete 
software package unopened to your supplier.
© 2005 Wordcraft International Limited
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Notice to Users

USE OF RECYCLED PAPER IN THE COPIER
As with all copiers and reproduction devices, the use of the appropriate paper ensures the best image 
quality of the copies and the machine’s performance and reliability.
Because of the extreme variances in composition and quality of paper from various manufacturers, con-
sumers should ensure the recycled paper they use is suitable for the copier. In accordance with the EPA 
Energy Star Program guidelines, TOSHIBA recommends the following recycled paper for use in the 
copier-

Great White MultiUse 20 paper

If you have any questions regarding the use of recycled paper in your copier, contact your authorized 
service technician.

FCC NOTICE
This equipment has been tested and found to comply with the limits for a Class A digital device, pursu-
ant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment 
generates, uses and can radiate radio frequency energy and, if not installed and used in accordance 
with the instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user will be 
required to correct the interference at his own expense.

WARNING
Changes or modification made to this equipment, not expressly approved by TOSHIBA TEC or parties 
authorized by TOSHIBA TEC, could void the user’s authority to operate the equipment.

This Class A digital apparatus complies with Canadian ICES-003.
Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

Download from Www.Somanuals.com. All Manuals Search And Download.



6    Lineup of Our Manuals

Lineup of Our Manuals

Thank you for purchasing the TOSHIBA multifunctional digital systems e-STUDIO163/203/165/
205.
We have provided you with these manuals for the operation of this equipment. Select and read 
the manual best suited to your needs.

To read manuals in PDF (Portable Document Format) files
Viewing and printing this operator’s manual in PDF files require that you install Adobe Reader or 
Adobe Acrobat Reader on your PC. If Adobe Reader or Adobe Acrobat Reader is not installed 
on your PC, download and install it from the website of Adobe Systems Incorporated.

Operator’s Manual for Copying Functions
e-STUDIO163/203
This manual describes the basic operations, mainly copying 
functions, of this equipment. It also describes safety precau-
tions to ensure correct and safe use of this equipment. Be 
sure to read this before you use the equipment.

Operator’s Manual for Copying Functions
e-STUDIO165/205
This manual describes the basic operations, mainly copying 
functions, of this equipment. It also describes safety precau-
tions to ensure correct and safe use of this equipment. Be 
sure to read this before you use the equipment.

Operator’s Manual for TOSHIBA Viewer (PDF)
This manual describes how to use the co-packed application 
software TOSHIBA Viewer, and how to print data from other 
Windows applications to this equipment.
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Before Reading This Manual

This operator’s manual describes the following:
How to use this equipment
How to inspect and carry out maintenance on this equipment
How to remedy mechanical and copying problems

Precautions in this manual
To ensure correct and safe use of this equipment, this operator’s manual describes safety pre-
cautions according to the three levels shown below.
You should fully understand the meaning and importance of these items before reading this 
manual.

Other than the above, this manual also describes information that may be useful for the opera-
tion of this equipment with the following signage:

Trademarks
Microsoft and Windows are the trademarks of Microsoft Corporation in the US and other 
countries.
Adobe, Adobe Acrobat, Adobe Reader and Adobe Acrobat Reader are the trademarks of 
Adobe Systems Incorporated.
Other company or product names shown in this manual may be a brand name or a trade-
mark of each company.

©2005 TOSHIBA TEC CORPORATION All rights reserved
Under the copyright laws, this manual cannot be reproduced in any form without prior written 
permission of TOSHIBA TEC CORPORATION. No patent liability is assumed, however, with 
respect to the use of the information contained herein.

Indicates a potentially hazardous situation which, if not avoided, could result 
in death, serious injury, or serious damage, or fire in the equipment or sur-
rounding assets.

Indicates a potentially hazardous situation which, if not avoided, may result in 
minor or moderate injury, partial damage of the equipment or surrounding 
assets, or loss of data.

Indicates a procedure you should follow to ensure the optimal performance of 
the equipment and problem-free copying.

Describes handy information that is useful to know when operating the equip-
ment.

Pages describing items related to what you are currently doing. See these 
pages as required.
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1.INTRODUCTION

This section describes the overview of TOSHIBA Viewer.
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Introduction

“TOSHIBA Viewer” has been specially designed for use with the Toshiba Multifunctional Digital 
Systems e-STUDIO163/203/165/205 and TWAIN compatible scanning devices.
Available features of TOSHIBA Viewer include:

Using your e-STUDIO163/203/165/205 as a printer.
Using your e-STUDIO163/203/165/205 as a scanner.
Configuring your e-STUDIO163/203/165/205 from the PC.
Scanning hard copy documents using your TWAIN scanner.
Creating graphics files in the TOSHIBA Viewer.
Storing properties of files in the Unimessage Pro folders to be used with TOSHIBA Viewer’s 
sophisticated search engine.
Routing of scanned images using TOSHIBA Viewer’s simple wizard style Routing Rules.
Create or edit the Phone/Fax numbers stored in your e-STUDIO165/205 from the PC.
(only for the e-STUDIO165/205 with the fax option installed)
Creating contacts in your TOSHIBA Viewer Phonebooks for frequently used fax numbers 
and E-mail addresses.
(only for the e-STUDIO165/205 with the fax option installed)

The Fax functions are only available for the e-STUDIO165/205 with the fax option installed.
The functions of TOSHIBA Viewer are not available for the e-STUDIO165/205 with the 
optional Network Printer Kit installed.

This manual gives instructions on how to install the GDI printer driver, TWAIN scanner driver 
and TOSHIBA Viewer and basic information about some of the other functions listed above.

Download from Www.Somanuals.com. All Manuals Search And Download.



2.INSTALLATION

This section describes the instructions on how to install the printer/scanner driver and TOSHIBA Viewer on 
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About Installation

Before installing the printer/scanner driver and TOSHIBA Viewer, please read this section to 
ensure the requirements for the installation, and understand the various ways of the installation 
that you are provided.

Before Installing the Softwares

Computer Requirements
The Requirements indicated here are minimums.
As with most Windows applications, TOSHIBA Viewer will run faster when used on a PC with a 
faster processor or with more RAM.
If you are using other applications on your PC at the same time as TOSHIBA Viewer, a faster 
processor and additional RAM are highly recommended.

The TOSHIBA Viewer system is compatible with Microsoft Windows 98 Second Edition, 
Microsoft Windows Me, Microsoft Windows 2000, Microsoft Windows XP or Microsoft Windows 
Server 2003.
Make sure that your computer meets the following criteria.

The TOSHIBA Viewer system is not applicable to a 64-bit OS.

PC: PC/AT 100% compatible; Pentium 120 MHz or higher for 
Windows 98 Second Edition
PC/AT 100% compatible; Pentium 150 MHz or higher for 
Windows Me or Windows 2000 Professional
PC/AT 100% compatible; Pentium 300 MHz or higher for 
Windows XP Home or Professional, or Windows 2000 
Server
PC/AT 100% compatible; Pentium 400 MHz or higher for 
Windows Server 2003

Operating system: Microsoft Windows 98 Second Edition
Microsoft Windows Me
Microsoft Windows 2000 Professional or Server
Microsoft Windows XP Home or Professional
Microsoft Windows Server 2003

PC memory: 32M Bytes RAM for Windows 98 Second Edition
64M Bytes RAM (128MB recommended) for Windows Me or 
Windows 2000 Professional
128M Bytes RAM for Windows XP Home or Professional
256M Bytes RAM for Windows 2000 Server
512M Bytes RAM for Windows Server 2003

Display: A 24 bit color video card and driver is recommended
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Configuration of the TOSHIBA Viewer CD-ROM
The configuration of the TOSHIBA Viewer CD-ROM and the purposes for each folder are as 
described below.

\Toshiba Viewer
Includes the Setup.exe to install the TOSHIBA Viewer, printer driver and TWAIN driver.
\Driv_USB\e-ST163,203,165,205\Win98SE
Includes the USB driver for Windows 98 SE
\Driv_USB\e-ST163,203,165,205\WinMe
Includes the USB driver for Windows Me
\Driv_USB\e-ST163,203,165,205\Win2k
Includes the USB driver for Windows 2000
\Driv_USB\e-ST163,203,165,205\WinXP
Includes the USB driver for Windows XP
\Driv_USB\e-ST163,203,165,205\Win2003
Includes the USB driver for Windows Server 2003
\Driv9xMe\Local
Includes the printer driver and TWAIN driver for ADD Printer function in Windows 98 SE/Me 
that e-STUDIO163/203/165/205 is connected in local.
\Driv9xMe\Network
Includes the printer driver for the network client computers of Windows 98 SE/Me
\Driv2kXp\Local
Includes the printer driver and TWAIN driver for ADD Printer function in Windows 2000/XP/
Server 2003 that e-STUDIO163/203/165/205 is connected in local.
\Driv2kXp\Network
Includes the printer driver for the network client computers of Windows 2000/XP/Server 2003
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Navigating your Installation
There are many different ways of installing the e-STUDIO163/203/165/205 softwares according 
to the environments or your requirements.
Please carefully read the instruction below and find out what you should do for installing the soft-
wares.

 P.17 “Installing the USB Driver”
First of all, it is recommended to install the USB driver when connecting the e-STUDIO163/
203/165/205 to your PC via the USB cable.

 P.33 “Installing the Printer Driver to the Local Client”
After you install the USB driver, you can install the GDI printer driver when connecting the e-
STUDIO163/203 to your PC in local. For Windows 2000, XP, Server 2003, the printer driver 
can be installed automatically when you install the USB driver.
This driver allows you to print the document with e-STUDIO163/203.

 P.66 “Installing the TOSHIBA Viewer”
After you install the GDI printer driver, you can install the TOSHIBA Viewer if you want use 
this utility.
This utility allows you to control your e-STUDIO163/203/165/205 from your PC, such as 
scanning, copying, and configuring the device settings. For further details of the TOSHIBA 
Viewer, see the following page.

 P.116 “Description of the Main Welcome Menu”
 P.90 “Installing the Printer Driver to the Network Client”

You can also install the GDI printer driver to the network clients.
This allows printing from the network clients with e-STUDIO163/203/165/205.

Screens used in the installation procedures of the above softwares are captured in system envi-
ronment with the e-STUDIO163 connected.
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Installing the USB Driver

Never turn the power off of the equipment or pull out the USB cable while you are installing the 
e-STUDIO163/203/165/205 software and data communication is being performed between the 
equipment and your PC.

From the Plug-and-Play Prompt
When using the e-STUDIO163/203/165/205 is connected to your PC via the USB cable and 
powered on Windows will prompt to install drivers for the new hardware. 
Drivers are provided on the CD in the "Driv_USB" folder, select to install drivers from this spe-
cific location.

These drivers will install an additional COM port, in Windows through which the Toshiba Viewer 
will then communicate with the e-STUDIO163/203/165/205. There are various ways of installa-
tion according to the Windows version running on your PC.

 P.17 “Windows 98 SE/Me”
 P.23 “Windows 2000”
 P.28 “Windows XP/Server 2003”

Windows 98 SE/Me
The following describes an installation on Windows 98 Second Edition.
The procedure is almost the same when Windows Me is used.

Make sure you understand the following information.
An additional COM port can only be installed on your PC by your executing USB driver installa-
tion two times. Even if you finish the installation by clicking the [Finish] button on the “Add New 
Hardware Wizard”, the communication port will not be installed. When the “Add New Hardware 
Wizard” appears again after clicking the [Finish] button, follow the procedure in the manual to 
execute the USB driver installation once again.

1 Connect the e-STUDIO163/203/165/205 to the computer by a USB 
cable, make sure it is turned on and start Windows.
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2 When Windows detects the device, the Plug-and-Play screen is dis-
played.
Windows 98 SE
Click [Next].

Windows Me
Proceed to step 3.
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3 Select what you want Windows to do.
Windows 98 SE
Select [Search for the best driver for your device (Recommended)] and click [Next].

Windows Me
Select [Specify the location of the driver (Advanced)] and click [Next].
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4 Select the search location.
Select [Specify a location] and click [Browse].

5 Insert the TOSHIBA Viewer CD-ROM in to the CD-ROM drive.

6 Browse to the USB driver folder.
Windows 98 SE
To install the USB driver, locate “[CD-ROM drive]:\Driv_USB\e-ST163,203,165,205\ 
Win98SE”.
Windows Me
To install the USB driver, locate “[CD-ROM drive]:\Driv_USB\e-ST163,203,165,205\ 
WinMe”.
Select the folder and click [OK].
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7 Click [Next].

8 Click [Next].
It starts copying file.
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9 Click [Finish] to complete the installation.
Proceed to step 10.
An additional COM port is installed on your PC by your executing USB driver installation 
two times.

10 The “Add New Hardware Wizard” appears again.
Follow steps 2 to 9 to execute the USB driver installation once again.

This will install an additional COM port, e. g. COM3 if the PC already has COM1 and 
COM2, through which the device driver will communicate with the e-STUDIO163/203/
165/205 device.
Proceed to step 11.
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11 After the USB driver is installed, “Add Printer Wizard” appears.
Follow steps 4 and after in the section “From the Add Printer Wizard” to install the printer 
driver for the e-STUDIO163/203/165/205.

 P.34 “From the Add Printer Wizard”

If “Add Printer Wizard” does not appear, or you clicked the [Cancel] button on “Add 
Printer Wizard”, go to the following page to install the printer driver for the e-STUDIO163/
203/165/205.

 P.34 “From the Add Printer Wizard”

Windows 2000

Please make sure that you have Administrator access right.

1 Connect the e-STUDIO163/203/165/205 to the computer by a USB 
cable, make sure it is turned on and start Windows.

2 When Windows detects the device, the Plug-and-Play screen is dis-
played.
Click [Next].
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3 Select what you want Windows to do.
Select [Search for a suitable driver for my device (recommended)] and click [Next].

4 Select the search location.
Select [Specify a location] and click [Next].
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5 Insert the TOSHIBA Viewer CD-ROM to the CD-ROM drive.
Click [Browse].

6 Browse to the USB driver folder.
To install the USB driver, locate “[CD-ROM drive]:\Driv_USB\e-ST163,203,165,205\ 
Win2k” then specify the language sub-folder you want to install and click [Open].

7 Click [OK].
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8 Click [Next].
It starts copying file.

9 Click [Yes].
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10 After the USB driver is installed, installation of the printer driver for 
the e-STUDIO163/203/165/205 automatically begins.
Click [Yes].

11 Click [Finish] to complete the installation.
This will install an additional COM port, e. g. COM3 if the PC already has COM1 and 
COM2, through which the device driver will communicate with the e-STUDIO163/203/
165/205 device.
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Windows XP/Server 2003
The following describes an installation on Windows XP.
The procedure is almost the same when Windows Server 2003 is used.

Please make sure that you have Administrator access right.

1 Connect the e-STUDIO163/203/165/205 to the computer by a USB 
cable, make sure it is turned on and start Windows.
The Found New Hardware Wizard dialog box appears.

2 Select whether or not Windows connects to Windows Update to 
search for software.
Select [No, not this time] and click [Next].

This screen is not displayed with versions prior to SP2.
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3 Select what you want Windows to do.
Select [Install from a list or specific location (Advanced)] and click [Next].

4 Select the search location.
Select [Search for the best driver in these locations] and [Include this location in 
the search]. Click [Browse].

5 Insert the Toshiba Viewer CD-ROM in to the CD-ROM drive.
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6 Browse to the USB driver folder.
Windows XP
To install the USB driver, locate "[CD-ROM drive]:\Driv_USB\e-ST163,203,165,205\ 
WinXP", then specify the language sub-folder you want to install.
Windows Server 2003
To install the USB driver, locate "[CD-ROM drive]:\Driv_USB\e-ST163,203,165,205\ 
Win2003", then specify the language sub-folder you want to install.
Select the folder and click [OK].

7 Click [Next].
It starts copying files.
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8 Click [Continue Anyway].

9 After the USB driver is installed, installation of the printer driver for 
the e-STUDIO163/203/165/205 automatically begins.
Click [Continue Anyway]. 
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10 Click [Finish] to complete the installation.
This will install an additional COM port, e.g. COM3 if the PC already has COM1 and 
COM2, through which the device driver will communicate with the e-STUDIO163/203/
165/205 device.
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Installing the Printer Driver to the Local Client

Before installing the Printer Driver

Before installing the printer driver, please follow the 
instruction described here.

When you have already installed the previous version of the Printer Driver on 
your PC...
Please delete the printer driver from the Printers folder as soon as you start the Windows.
(The printer driver cannot be deleted properly when the printer driver had been used before 
deleting.)
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From the Add Printer Wizard
Upon connecting the e-STUDIO163/203/165/205 to your PC as a local (COM) device, you can 
install the printer driver for this e-STUDIO163/203/165/205 using this procedure.
There are various ways of installation according to the Windows version running on your PC.

 P.34 “Windows 98 SE/Me”
 P.42 “Windows 2000”
 P.54 “Windows XP/Server 2003”

Windows 98 SE/Me
The printer drivers in the languages listed below are on the CD-ROM supplied with your 
machine.
Please select the language sub-folder by following the language of the Windows you are using.

The following describes an installation on Windows 98 Second Edition.
The procedure is almost the same when Windows Me is used.

Please make sure that following terms are satisfied.
Close all applications that are running to avoid any conflicts during installation.
The TOSHIBA e-STUDIO163/203/165/205 is connected to your PC and powered on. 
The USB driver has been already installed on your PC.
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1 Open the [Printers] folder.
Click [Start] and select [Settings/Printers].

2 Double click on [Add Printer] icon.
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3 Click [Next].

4 Select [Local printer].
Click [Next].
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5 Windows presents a list of printers it knows about.
Click [Have Disk].

6 Insert the TOSHIBA Viewer CD-ROM in to the CD-ROM drive.
Click [Browse].

7 Browse to the printer driver folder.
Browse to the appropriate language sub-folder of the “Local” folder in the “Driv9xMe” 
folder. Highlight “oemsetup.inf” and click [OK].
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8 Click [OK].

9 Select the appropriate printer from the list.
Click [Next].
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10 Select whether or not you use the existing printer driver.
Select [Keep existing driver (recommended)] and click [Next].

This screen appears when the e-STUDIO163/203/165/205 printer driver has been 
already installed on your PC.
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11 Select the port to which your printer is connected.
Select [COM port] and click [Next].

Specify the COM port which is set when installing the USB driver to your PC.
 P.17 “Installing the USB Driver”

Example: COM3
The new COM port will appear in the [Ports] section of Windows' [Device Manager], 
you can open Device Manager to check what port number has been assigned as fol-
lows:
Windows 98 SE/Me: Click [Start], [Control Panel], [System], select the [Device 
Manager] tab, expand the [Ports] branch.

12 Type the printer name and select whether or not you use e-STUDIO 
163/203/165/205 as the default printer.
Rename the printer name if required. Click [Finish]. Files will be copied and installed.
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13 Insert the disk labeled “Windows 98 Second Edition CD-ROM” to 
the CD-ROM drive and click [OK].

14 Complete the installation.
Your e-STUDIO163/203/165/205 printer driver is now installed and ready to use.
If you wish you can print a test page from [Control Panel]/[Printers], by double clicking 
on the printer icon and selecting [Print Test Page] on the [General] tab of the printer’s 
properties.

To remove your printer, driver simply open [Control Panel]/[Printers], highlight the 
printer and press the [Delete] key on your keyboard.
When you want to use the TOSHIBA Viewer, go to the following page and install the 
TOSHIBA Viewer.

 P.66 “Installing the TOSHIBA Viewer”
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Windows 2000
The printer drivers in the languages listed below are on the CD-ROM supplied with your 
machine.
Please select the language sub-folder by following the language of the Windows you are using.

Please make sure that following terms are satisfied.
Close all applications that are running to avoid any conflicts during installation.
The TOSHIBA e-STUDIO163/203/165/205 is connected to your PC and powered on.
The USB driver has been already installed on your PC.
Make sure you have Administrator access rights.
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1 Open the [Printers] folder.
Click [Start] and select [Settings/Printers].

2 Double click on [Add Printer] icon.
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3 Click [Next].

4 Select [Local printer].
Uncheck [Automatically detect and install my Plug and Play printer] and click [Next].
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5 Select the port to which your printer is connected.
Select [COM port] and click [Next].

Specify the COM port which is set when installing the USB driver to your PC.
 P.17 “Installing the USB Driver”

Example: COM3
The new COM port will appear in the [Ports] section of Windows' [Device Manager], 
you can open Device Manager to check what port number has been assigned as fol-
lows:
Windows 2000: Click [Start], [Settings], [Control Panel], [System], select the 
[Hardware] tab, click the [Device Manager] button, expand the [Ports] branch.
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6 Windows presents a list of printers it knows about.
Click [Have Disk].

7 Insert the TOSHIBA Viewer CD-ROM in to the CD-ROM drive.
Click [Browse].
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8 Browse to the printer driver folder.
Browse to the appropriate language sub-folder of the “Local” folder in the “Driv2kXp” 
folder.
Highlight “oemsetup.inf” and click [Open].

9 Click [OK].
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10 Select the appropriate printer from the list.
Click [Next].

11 Select whether or not you use the existing printer driver.
Select [Keep existing driver (recommended)] and click [Next].

This screen appears when the e-STUDIO163/203/165/205 printer driver has been 
already installed on your PC.
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12 Type the printer name and select whether or not you use e-STUDIO 
163/203/165/205 as the default printer.
Rename the printer name if required and click [Next].

13 Select the printer is shared with network clients or not.
(1) If you want this printer to be used by only the local client, select [Do not share this 

printer]. If you want this printer to be shared with network clients, select [Shared as] 
and enter the shared printer name.

(2) Click [Next].

Download from Www.Somanuals.com. All Manuals Search And Download.



2 INSTALLATION

50    Installing the Printer Driver to the Local Client

14 Select whether printing the test page or not.
(1) If you want to print a test page, select [Yes]. If you do not want to print a test page, 

select [No].
(2) Click [Next].

15 Click [Finish] to complete the Add Printer Wizard.
Your e-STUDIO163/203/165/205 Series printer driver is now installed.
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16 Click [Yes].
The installation is continued and your e-STUDIO163/203/165/205 Series printer driver 
becomes ready to use.

When you want to use the TOSHIBA Viewer, go to the following page and install the 
TOSHIBA Viewer.  P.66 “Installing the TOSHIBA Viewer”
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17 Make sure a test page is successfully printed when you request 
printing a test page.
If a test page is successfully printed, click [OK] to complete the installation.
If a test page is not successfully printed, click [Troubleshoot].

To remove your printer driver, follow the steps below:
1. Open [Control Panel]/[Printers], highlight the TOSHIBA e-STUDIO163/203/165/205 

and press the [Delete] key on your keyboard to remove the printer icon.
2. Select Server Properties from the [File] menu.
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3. Open the drivers tab and highlight the TOSHIBA e-STUDIO163/203/165/205 driver.

4. Click [Remove].
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Windows XP/Server 2003
The printer drivers in the languages listed below are on the CD-ROM supplied with your 
machine.
Please select the language sub-folder by following the language of the Windows you are using.

The following describes an installation on Windows XP.
The procedure is almost the same when Windows Server 2003 is used.

Please make sure that following terms are satisfied.
Close all applications that are running to avoid any conflicts during installation.
The TOSHIBA e-STUDIO163/203/165/205 is connected to your PC and powered on. 
The USB driver has been already installed on your PC.
Make sure you have Administrator access rights.
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1 Open the [Printers and Faxes] folder.
Click [Start] and select [Printers and Faxes].

2 Select [Add a printer].
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3 Click [Next].

4 Select [Local printer attached to this computer].
Uncheck [Automatically detect and install my Plug and Play printer] and click [Next].
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5 Select the port to which your printer is connected.
Select [COM port] and click [Next].

Specify the COM port which is set when installing the USB driver to your PC.
 P.17 “Installing the USB Driver”

Example: COM3
The new COM port will appear in the [Ports] section of Windows' [Device Manager], 
you can open Device Manager to check what port number has been assigned as fol-
lows:
Windows XP: Click [Start], [Control Panel], [Performance] and [Maintenance], 
[System], select the [Hardware] tab, click the [Device Manager] button, expand the 
[Ports] branch.
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6 Windows presents a list of printers it knows about.
Click [Have Disk].

7 Insert the TOSHIBA Viewer CD-ROM in to the CD-ROM drive.
Click [Browse].
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8 Browse to the printer driver folder.
Browse to the appropriate language sub-folder of the “Local” folder in the “Driv2KXP” 
folder. Highlight “oemsetup.inf” and click [Open].

9 Click [OK].
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10 Select the appropriate printer from the list.
Click [Next].

11 Select whether or not you use the existing printer driver.
Select [Keep existing driver (recommended)] and click [Next].

This screen appears when the e-STUDIO163/203/165/205 printer driver has been 
already installed on your PC.
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12 Type the printer name.
(1) Rename the printer name if required.
(2) Select whether or not you use e-STUDIO163/203/165/205 as the default printer.
(3) Click [Next].

13 Select the printer is shared with network clients or not.
(1) If you want this printer to be used by only the local client, select [Do not share this 

printer]. If you want this printer to be shared with network clients, select [Share 
name] and enter the shared printer name.

(2) Click [Next].
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14 Select whether printing the test page or not.
(1) If you want to print a test page, select [Yes]. If you do not want to print a test page, 

select [No].
(2) Click [Next].

15 Click [Finish] to complete the Add Printer Wizard.
Your e-STUDIO163/203/165/205 Series printer driver is now installed.
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16 Click [Continue Anyway].
The installation is continued and your e-STUDIO163/203/165/205 Series printer driver 
becomes ready to use.

When you want to use the TOSHIBA Viewer, go to the following page and install the 
TOSHIBA Viewer.  P.66 “Installing the TOSHIBA Viewer”
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17 Make sure a test page is successfully printed when you request 
printing a test page.
If a test page is successfully printed, click [OK] to complete the installation.
If a test page is not successfully printed, click [Troubleshoot].

To remove your printer driver, follow the steps below:
1. Open [Printers and Faxes], highlight the TOSHIBA e-STUDIO163/203/165/205 and 

press the [Delete] key on your keyboard to remove the printer icon.
2. Select Server Properties from the [File] menu.
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3. Open the drivers tab and highlight the TOSHIBA e-STUDIO163/203/165/205 driver.

4. Click [Remove].
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Installing the TOSHIBA Viewer

Before installing the TOSHIBA Viewer
Before installing TOSHIBA Viewer, your TOSHIBA e-STUDIO163/203/165/205 must be con-
nected to your PC via a USB cable suitable for bi-directional communications.

Please make sure that following terms are satisfied.
When using Windows 2000/XP/Server 2003, make sure you have Administrator access 
rights.
Close all applications that are running to avoid any conflicts during installation.
The TOSHIBA e-STUDIO163/203/165/205 connected to your PC is powered on.

When the Plug-and-Play prompt is displayed...
When the Plug-and-Play prompt is displayed as soon as Windows is started, install the USB 
driver before installing the TOSHIBA Viewer.
About the instructions for installing the driver, see the following page.

 P.17 “Installing the USB Driver”

Installation
Prompts may vary depending on your PC configuration. The screens show examples of Win-
dows XP.

1 Insert the TOSHIBA Viewer CD-ROM in to the CD-ROM drive.
Click [Start] and select [Run].
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2 Type “F:\Toshiba Viewer\Setup.exe”.
Click [OK].

Type “F:\Toshiba Viewer\Setup.exe” where F is your CD-ROM drive.

3 Select Language.
Click [OK].
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4 Start the Installation.
Click [Next].

5 Read the [Software License Agreement].
If you agree the License Agreement, click [Yes]. If you click [No], exit the Installation. 
The Installation is not completed.
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6 Choose the Destination Location.
Click [Next].

7 Enter [Program Folder] Name or Select the [Program Folder].
Click [Next].
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8 Start the Copy.
Wait until file copying files is completed. The Setup Complete screen automatically 
appears.

If the GDI printer driver was installed prior to the installation of TOSHIBA Viewer, the wiz-
ard will issue a series of prompts indicating that several files already exist.
Simply instruct the wizard to overwrite the existing files.

9 Exit the Installation Window.
Select [Yes, I want to restart my computer now.], and click [Finish].

You have to restart the computer before using the TOSHIBA Viewer.
After restarting the computer, the Unimessage Pro device wizard automatically runs.

Download from Www.Somanuals.com. All Manuals Search And Download.



Installing the TOSHIBA Viewer    71

Device Setup
After restarting the computer, the [Unimessage Pro device wizard] automatically appears.

This device setup wizard can be operated by running the [Unimessage Pro Startup Wizard] in 
[Program Folder] as well.
When multiple TOSHIBA devices are connected to your PC, you can operate the device setups 
for each device.
Every time you operate the device setup, a new TOSHIBA Viewer utility is created.

1 Unimessage Pro device wizard appears.
Enter the details for each entry field. After all required entries are completed, click [Next].

At least [Name], [Address], [Location], [Telephone number], and [Fax number] must 
be entered.
The [Address] entry must be more than 10 letters.
The [Name] entry must be more than 2 letters.
The [Telephone number] and [Fax number] entries must be more than 8 numbers.
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2 Select the device driver installation type.
Select [Yes, look for devices connected to this computer and configure 
Unimessage Pro to use them], and click [Next].

3 Message to start scanning the system for network devices is dis-
played.
Click [Next].
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4 Scanning for network devices starts.
After scanning for network devices is completed, select one device from the list and click 
[Next].

5 Enter [System Device Name] and [Descriptive Device Name].
Default [System Device Name] and [Descriptive Device Name] are already entered. 
Rename them if required.
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6 Select [Custom] for the type of Setup.
Click [Next].

7 Select [Yes, install TWAIN components].
(1) TOSHIBA Viewer will ask if the TWAIN resource should be installed as you configure 

the device.
(2) Click [Next].
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8 Select [Yes, create a printer].
(1) TOSHIBA Viewer will ask if a printer driver for the e-STUDIO163/203/165/205 should 

be created or not.
If you choose to create this printer, it will be named after the e-STUDIO163/203/165/
205 but you can edit this name if you prefer.

(2) Click [Next].

Even if you choose not to create the printer driver during the definition of the device or it 
is deleted, you can create the printer driver for the e-STUDIO163/203/165/205 later.
To do this, open the Devices folder, right click on the appropriate device and select 
[Create printer].
For further details, see the [Help] for [Create printer].
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9 Select whether to create a shortcut and the location.
Click [Next].

10 Complete the device setup.
Click [Finish].
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11 TOSHIBA Viewer starts.

Download from Www.Somanuals.com. All Manuals Search And Download.



2 INSTALLATION

78    Installing the TOSHIBA Viewer

To utilize TOSHIBA Viewer when logging on as different user who also 
has Admin rights

When a user who has not installed TOSHIBA Viewer wants to utilize TOSHIBA Viewer utility, fol-
low the steps below to prepare the registry for the user.

This operation is applied to Windows 2000/XP/Server 2003.

The screens show examples of Windows XP.

1 Click [Start] – [All Programs] – [Unimessage Pro] – [Prepare Regis-
try for Unimessage Pro].

Download from Www.Somanuals.com. All Manuals Search And Download.



Installing the TOSHIBA Viewer    79

2 Browse for Folder dialog box appears.
Select the folder where Unimessage Pro has been installed and click [OK].

3 Select [Yes, run the front-end], the desired user and language, then 
click [Next].
Select the user name who has Administrator access rights.
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4 Select the device you use.
(1) When you use the device that has been already created, select [No, use devices 

connected to other computers.]. When you create a new device, select [Yes, look 
for devices connected to this computer and configure Unimessage Pro to use 
them.].

(2) Click [Next].

5 Select whether to create a shortcut and the location and click 
[Next].
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6 Click [Finish].

7 TOSHIBA Viewer starts.
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Uninstalling the TOSHIBA Viewer

Before uninstalling the TOSHIBA Viewer
When the following icon is displayed in the system tray (called task tray which is displayed at the 
very right on the Windows task bar), ensure to close the device driver before uninstalling the 
TOSHIBA Viewer.

Right click on the icon and select [Close].

Prompts may very depending on your PC configuration.
The screens show examples of Windows XP.

1 Select [Start], [Control Panel].
Double click [Add or Remove Programs].
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2 Select [Unimessage Pro].
Click [Change/Remove].

3 Confirm File Deletion dialog appears.
Click [Yes].

4 TOSHIBA Viewer alert dialog appears.
Exit all applications running on your machine because uninstallation causes to lose the 
unsaved data of which is running during the uninstallation, and click [OK].
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5 Uninstallation starts.
During the uninstallation, the confirmation dialogs for removing the shared files appear.

Click [Yes to All] to delete all shared files in the TOSHIBA Viewer program folder.
Click [No to All], if you intend to retain GDI printer driver installed separately.
After removing files is completed, click [OK].
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6 Confirm File Deletion dialog appears.
The confirmation dialog appears for removing files which are created after the 
installation. Click [YES] to delete the files.

7 Click [OK].
After removing files is completed, click [OK].

8 Restart your computer.
Restart your computer to complete the uninstallation. 
Some files are deleted after restarting the computer.
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Removing the e-STUDIO163/203/165/205 COM Port

Before removing the e-STUDIO163/203/165/205 COM port
When the following icon is displayed in the system tray (called task tray which is displayed at the 
very right on the Windows task bar), ensure to close the device driver before removing the e-
STUDIO163/203/165/205 COM port.

Right click on the icon and select [Close].

Make sure that e-STUDIO163/203/165/205 is connected to your PC using the USB cable and 
powered on.

The screens show examples of Windows XP.

1 Click [Start] and select [Control Panel].
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2 Open system properties.
Click [Performance and Maintenance] and click [System].

3 Open device manager.
Select the [Hardware] tab and click [Device Manager].
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4 Select the e-STUDIO163/203/165/205 COM port.
Expand the [Ports] branch and highlight the e-STUDIO163/203/165/205 COM port.

5 Remove the e-STUDIO163/203/165/205 COM port.
Select [Uninstall] from the [Action] menu or right click on the e-STUDIO163/203/
165/205 COM port icon and select [Uninstall].
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6 “Confirm Device Removal” dialog box appears.
Click [OK].
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Installing the Printer Driver to the Network Client

Before installing the Printer Driver
This section describes how to install the printer driver to the network clients computer.
This allows the network clients to print to e-STUDIO163/203/165/205, which is connected to a 
remote computer by a USB cable, through a network.

TOSHIBA Viewer GDI printer driver does not support Point and Print. Therefore, when installing 
the printer driver to the network client, follow the steps described here.

Before installing the printer driver, please make sure that following terms are satisfied.
The TOSHIBA e-STUDIO163/203/165/205 is connected to the remote computer by USB 
cable and powered on, and the USB driver is installed.
The printer driver is already correctly installed on the remote computer and shared.
You have access rights to the remote computer and printer. (only when required)]

There are various ways of installation according to the Windows version running on your PC.
 P.90 “Windows 98 SE/Me”
 P.95 “Windows 2000”
 P.103 “Windows XP/Server 2003”

Windows 98 SE/Me
The printer drivers in the languages listed below are on the CD-ROM supplied with your 
machine.
Please select the language sub-folder by following the language of the Windows you are using.

\Bra_Por

\CaFrench

\Chinese

\Danish

\Dutch

\Finnish

\French

\German

\Italian

\Mex_Span

\Norwe

\Portu

\Spanish

\Swedish

\UK_Eng

\US_Eng

: Portuguese [Brazilian]

: French [Canadian]

: Chinese

: Danish

: Dutch

: Finnish

: French

: German

: Italian

: Spanish [Mexican]

: Norwegian

: Portuguese

: Spanish

: Swedish

: English [UK]

: English [US]
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The following describes an installation on Windows 98 Second Edition.
The procedure is almost the same when Windows Me is used.

Please make sure that following terms are satisfied.
Close all applications that are running to avoid any conflicts during installation.
The TOSHIBA e-STUDIO163/203/165/205 is connected to your PC and powered on.

1 Browse to the network printer.
(1) Using Explorer, browse to the workstation or server that contains the shared printer 

that you want to install.
(2) Double click on the printer.

2 Click [Yes] to install.
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3 Select [No] because there is no MS-DOS printer driver for the 
e-STUDIO163/203/165/205 and click [Next].
If the operating system of the remote computer is the Windows 98 SE/Me, skip the 
procedure to step 10.
If the operating system of the remote computer is not the Windows 98 SE/Me, continue to 
next step.

4 Windows presents a list of printers it knows about.
Click [Have Disk].
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5 Insert the TOSHIBA Viewer CD-ROM in to the CD-ROM drive.
Click [Browse].

6 Browse to the printer driver folder.
Browse to the appropriate language sub-folder of the “Network” folder in the “Driv9xMe” 
folder.
Highlight “oemsetup.inf” and click [OK].

7 Click [OK].
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8 Select the appropriate printer from the list.
Click [Next].

9 Type the printer name.
(1) Rename the printer name if required.
(2) Click [Finish]. Files will be copied and installed. Your e-STUDIO163/203/165/205 

Series printer driver is now installed and ready to use.

To remove your printer driver, simply open [Control Panel]/[Printers], highlight the printer 
and press the [Delete] key on your keyboard.
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Windows 2000
The printer drivers in the languages listed below are on the CD-ROM supplied with your 
machine.
Please select the language sub-folder by following the language of the Windows you are using.

Please make sure that following terms are satisfied.
Close all applications that are running to avoid any conflicts during installation.
Make sure you have Administrator access rights.

1 Open the [Printers] folder.
Click [Start] and select [Settings]/[Printers].

\Bra_Por

\CaFrench

\Chinese

\Danish

\Dutch

\Finnish

\French

\German

\Italian

\Mex_Span

\Norwe

\Portu

\Spanish

\Swedish

\UK_Eng

\US_Eng

: Portuguese [Brazilian]

: French [Canadian]

: Chinese

: Danish

: Dutch

: Finnish

: French

: German

: Italian

: Spanish [Mexican]

: Norwegian

: Portuguese

: Spanish

: Swedish

: English [UK]

: English [US]
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2 Double click on [Add Printer] icon.

3 Click [Next].
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4 Select [Network printer].
Click [Next].

5 Click [Next] to browse for the printer you want to use.
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6 Browse and select the network printer you want install and click 
[Next].
If the operating system of the remote computer is the Windows 2000/XP/Server 
2003
skip the procedure to step 14.
If the operating system of the remote computer is not the Windows 2000/XP/Server 
2003
continue to next step.

7 Click [OK].
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8 Windows presents a list of printers it knows about.
Click [Have Disk].

9 Insert the TOSHIBA Viewer CD-ROM in to the CD-ROM drive.
Click [Browse].
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10 Browse to the printer driver folder.
Browse to the appropriate language sub-folder of the “Network” folder in the “Driv2kXP” 
folder.
Highlight “oemsetup.inf” and click [Open].

11 Click [OK].

12 Select the appropriate printer from the list.
Click [Next].
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13 Click [Yes].

14 Click [Next].
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15 Click [Finish] to complete the installation.
Your e-STUDIO163/203/165/205 Series printer driver is now installed and ready to use.

To remove your printer driver, follow the steps below:
1. Open [Control Panel]/[Printers], highlight the TOSHIBA e-STUDIO163/203/165/205 

and press the [Delete] key on your keyboard to remove the printer icon.
2. Select Server Properties from the [File] menu.
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3. Open the drivers tab and highlight the TOSHIBA e-STUDIO163/203/165/205 driver.

4. Click [Remove].

Windows XP/Server 2003

Before installing the Printer Driver
Before installing the printer driver, please make sure that following terms are satisfied.

The TOSHIBA Multifunctional Digital Systems is connected to the remote computer by a 
USB cable and powered on.
The printer driver is already correctly installed on the remote computer and shared.
You have access rights to the remote computer and printer.

When you install the printer driver to the Windows XP/Server 2003, if the Internet Connection 
Firewall function newly provided by the Windows XP/Server 2003 is set to ON, it is impossible to 
share the files.
Therefore, the printer driver cannot be installed to the network client computer.
In this case, follow the procedure described below to turn OFF the Internet Connection Firewall 
function of the Windows XP/Server 2003.

Select the menus in the following order.
Start, Control Panel, Network and Internet Connections, Network Connections
Click the Local Area Connection by right button of your mouse, and select “properties” dis-
played on the bottom of the menu.
Select the Advanced tab and de-select the Internet Connection Firewall check box.

The above settings could be different according to your network environment.
If you need additional assistance, please ask your network administrator.

Download from Www.Somanuals.com. All Manuals Search And Download.



2 INSTALLATION

104    Installing the Printer Driver to the Network Client

The printer drivers in the languages listed below are on the CD-ROM supplied with your 
machine. Please select the language sub-folder corresponding to the language of the Windows 
version you are using.

The following describes an installation on Windows XP.
The procedure is almost the same when Windows Server 2003 is used.

Please make sure that following terms are satisfied.
Close all applications that are running to avoid any conflicts during installation.
Make sure you have Administrator access rights.

\Bra_Por

\CaFrench

\Chinese

\Danish

\Dutch

\Finnish

\French

\German

\Italian

\Mex_Span

\Norwe

\Portu

\Spanish

\Swedish

\UK_Eng

\US_Eng

: Portuguese [Brazilian]

: French [Canadian]

: Chinese

: Danish

: Dutch

: Finnish
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: German

: Italian

: Spanish [Mexican]

: Norwegian

: Portuguese

: Spanish

: Swedish

: English [UK]

: English [US]
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1 Open the [Printers and Faxes folder].
Click [Start] and select [Printers and Faxes].

2 Click Add a printer.
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3 Click [Next].

4 Select [A network printer, or a printer attached to another com-
puter].
Click [Next].
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5 Click [Next] to browse for the printer you want to use.

6 Browse and select the network printer you want install and click 
[Next].
If the operating system of the remote computer is the Windows 2000/XP/Server 
2003
skip the procedure to step 14.
If the operating system of the remote computer is not the Windows 2000/XP/Server 
2003
continue to next step.

7 Click [OK].
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8 Windows presents a list of printers it knows about.
Click [Have Disk].

9 Insert the TOSHIBA Viewer CD-ROM in to the CD-ROM drive.
Click [Browse].

10 Browse to the printer driver folder.
Browse to the appropriate language sub-folder of the “Network” folder in the “Driv2kXp” 
folder. Highlight “oemsetup.inf” and click [Open].
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11 Click [OK].

12 Select the appropriate printer from the list.
Click [OK].

13 Click [Continue Anyway].

Download from Www.Somanuals.com. All Manuals Search And Download.



2 INSTALLATION

110    Installing the Printer Driver to the Network Client

14 Select the Default Printer.
(1) If you want to use this printer as the default printer, select [Yes]. If you do not want to 

use this printer as the default printer, select [No].
(2) Click [Next].
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15 Click [Finish] to complete the installation.

To remove your printer driver, follow the steps below:
1. Open [Printers and Faxes], highlight the TOSHIBA e-STUDIO163/203/165/205 and 

press the [Delete] key on your keyboard to remove the printer icon.
2. Select Server Properties from the [File] menu.
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3. Open the drivers tab and highlight the TOSHIBA e-STUDIO163/203/165/205 driver.

4. Click [Remove].
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Supplement

Cancelling print jobs
Print jobs can be cancelled from the Windows print queue. 
Select [Start, Setting], [Printers] and double click on the printer. Highlight the job to be can-
celled and press the [Delete] key (or right click on the job and select [Delete] or [Cancel]).

Print jobs may also be cancelled after they have left this point by closing the printer driver from 
the “System Tray” - near the Windows’ clock.
The driver’s icon in the “System Tray” is shown below:

To cancel the print jobs, right click on the icon and select [Close].

The driver will then close as soon as possible.
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This section describes each function that is accessible from the TOSHIBA Viewer Main Welcome Menu.
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Description of the Main Welcome Menu

Summary of each menu
Descriptions and instructions for general functions are described in this section.
For details and instructions other than those described in this manual, please see the TOSHIBA 
Viewer on-line Help.

To activate TOSHIBA Viewer
Click [Start], [All Programs], [Unimessage Pro], [Unimessage Pro]. The following screen is 
displayed.

From this menu you can access the main TOSHIBA Viewer system.
You can examine the lists of scanned and filed images by clicking the TOSHIBA Viewer logo.

The round buttons provide quick access to some of the TOSHIBA Viewer functions and can 
include a combination of the following:

Browse Folders: This takes you to the list of folders within TOSHIBA Viewer so that you 
can check on the progress of message, examine the lists of received, 
transmitted, filed messages and print these lists or individual mes-
sages.
Also, most of operation can be performed from the menus and folders 
on the screen displayed by clicking this button.
To know how can be operated, please see the following page and the 
TOSHIBA Viewer on-line Help for any other functions not instructed in 
the section.

 P.118 “Browse Folders”

Copy: This combines the functions of TWAIN scanning and printing and 
allows you to make multiple hardcopies of a document in the auto-
matic document feeder of the TWAIN scanner.
To know how can be operated, please see the following page.

 P.142 “Copy”

File Scan: This takes you to the TWAIN scanner driver for e-STUDIO163/203/
165/205, the TOSHIBA Viewer Scan setup dialog so that you can scan 
documents or images into your PC.
To know how can be operated, please see the following page and the 
TOSHIBA Viewer on-line Help for any other functions not instructed in 
the section.

 P.143 “File Scan”

Download from Www.Somanuals.com. All Manuals Search And Download.



Description of the Main Welcome Menu    117

Email Scan: This scans a document or image using any TWAIN scanner then auto-
matically attaches it to an E-mail message. 
To do this, an E-mail software must be installed on your PC.
To know how can be operated, please see the following page.

 P.146 “Email Scan”

Setup: This takes you to a dialog where settings on your e-STUDIO163/203/
165/205 can be configured from the PC.
This also can be operated from Browse Folders.
To know how can be operated, please see the following page.

 P.148 “Setup”

Help: To access TOSHIBA Viewer on-line Help.

Exit: To close TOSHIBA Viewer.
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Browse Folders

How to operate "Browse Folders" and each function
When you click Browse Folders button or the TOSHIBA Viewer logo on the Welcome menu, 
the TOSHIBA Viewer main display will appear.

When you close the main TOSHIBA Viewer display, the Welcome menu will reappear.
If you prefer to skip the Welcome menu, select Program from the Setup menu, click on the 
Application tab and uncheck the Show “welcome” screen option then click OK.
The Welcome menu will then not to be displayed beginning with the next time you start 
TOSHIBA Viewer.
You can switch between open folders in the main TOSHIBA Viewer display using Ctrl+TAB 
or Ctrl+F6.
You can close the current folder in the main TOSHIBA Viewer display using Ctrl+F4.

At the top of the Main TOSHIBA Viewer Display is the menu list - File, Edit, View, Message, 
Setup, Window, and Help.
Below the menu list is the main toolbar - Open, Print, Acquire, Copy and Find.
You can disable the toolbar display from the View menu.
At the foot of the screen is a status bar that will display various messages depending on what 
you are doing.
You can disable the status bar from the View menu.
 For further descriptions of the each menu item, select Contents and Index in Help menu to 
view the Help.

The remainder of the screen is divided into two parts:
On the left is the list of available folders.
To open a folder in the right pane, click its name in the folder tree.
If a folder contains any unread items TOSHIBA Viewer will display the number of unread 
items within each folder after each folder’s name in this section of the screen.
You can change the width of this area by placing your cursor on its right-hand border (the 
cursor will change shape), holding down the left mouse button, and dragging the border to a 
new position.
On the right is a display area for individual or multiple folders.
You can select folders to be displayed by clicking on them in the folder list.
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Changing the Device Information
During the Unimessage Device Wizard that concluded the installation process, you will have 
configured TOSHIBA Viewer for use with your e-STUDIO163/203/165/205.
Should you want to, you can reconfigure how TOSHIBA Viewer works with your e-STUDIO163/
203/165/205 via the Device folder.
Also you can remotely configure the device configuration using this program.

1 Open the [Device folder].
Double click the appropriate entry in the list of devices that appears in the right hand 
pane. Device settings appears.
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2 Change the TOSHIBA Viewer settings and the device settings.
(1) Click on [Device] tab.
(2) Check on [Print] and/or [Scan] if you want the e-STUDIO163/203/165/205 to work 

as a printer and/or scanner using the TOSHIBA Viewer.
When you want to change the port, go to Step 3.

(3) When you want to save changes, click on [OK].

When you want to configure the device settings, click on [Setup...].
For more details about the device settings, see the following page.

 P.148 “Setup”
Only make changes if you are sure, improper settings can cause unpredictable behav-
iour.
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3 Change the port.
(1) Click on [Port] tab.
(2) Select the port that your computer connects to your e-STUDIO163/203/165/205.
(3) Click on [OK] to save changes.

Changes made to a device’s properties will only take effect from the next time that you 
start the TOSHIBA Viewer, or close and then restart the device after editing its settings, 
as described below:

Select the device in Devices list.
Click the Log off toolbar button.
Click the Start toolbar button.
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Add/Edit Phonebook contacts on the e-STUDIO165/205
TOSHIBA Viewer permits you to remotely add/edit One Touch and/or Abbreviated Number con-
tacts on your e-STUDIO165/205.

This function is available only for the e-STUDIO165/205 with the fax option installed.

1 Open the Devices folder.
(1) Select the device and click the [Setup device phonebook] button.

(2) “Reading data from device” appears as Viewer interrogates the attached Multifunc-
tional Digital Systems.
Toshiba Phonebook Setup appears.

When you want to change the current device phonebook
go to Step 2.
When you want to change the phonebook by copying the settings from a set file 
located on your hard disk
go to Step 3.
When you want to change the phonebook by copying the settings from a user 
settings file stored within TOSHIBA Viewer
go to Step 4.

For further details on phonebook setup, refer to Help.
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2 Edit the phonebook.
To add new phonebook contacts
(1) Click on Abb. Numbers, Group Numbers, or One Touch Keys in the left pane.

Then double click on Add... (e.g. “Add Abb. Number”) in the right pane.
(2) Tel List Entry appears at the end of the existing list.
(3) Double click on the desired items and enter the appropriate values.

To edit phonebook contacts
(1) Double click on the item you want to edit then enter the new data.
(2) Click the [Write Settings] button to download the new settings to your 

e-STUDIO165/205.

Click the [Cancel] button to cancel adding/editing the phonebook contacts.
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3 Load a set file from your hard disk.
(1) Double-click on [Add settings file].
(2) A “New settings” file is created.

(3) Right-click on the new settings file and select Load....

In order to create a user phonebook file to be saved on your hard disk, refer to the sec-
tion “Saving the Phonebook”.

(4) The Load settings screen appears.
(5) Designate the hard disk location of the desired set file, select the file, then click on 

[Open].
(6) The set file is loaded.
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4 Copy the phonebook settings.
Left-click and hold on the user phonebook file, then drag it to the device phonebook file, 
and release the left mouse button.

Initially, your mouse pointer will become a “circle with diagonal line”.
Upon reaching the device phonebook file, the pointer will take the form of an “address 
label”.
Upon releasing the left mouse button, the contents of the user phonebook file are copied 
to the device phonebook file.

5 Click the [Write Settings] button.
The new settings is downloaded to your e-STUDIO165/205.

Click the [Cancel] button to cancel adding/editing the phonebook contacts.
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Save new phonebook
The device phonebook opened by TOSHIBA Viewer (default name TOSHIBA) is a temporary 
“working” file.
Every time TOSHIBA Viewer is opened, the program accesses the attached facsimile and reads 
the current phonebook settings.
You can store the phonebook settings within TOSHIBA Viewer or save as a set file on your hard 
disk.
This is useful when performing a full memory clear or upgrading the machine firmware because 
you can easily re-program the machine’s phonebook by downloading the stored phonebook file.

This function is available only for the e-STUDIO165/205 with the fax option installed.

1 Open the Device folder.
(1) Select the device and click the [Setup device phonebook] button.

(2) “Reading data from device” appears as Viewer interrogates the attached facsimile. 
Toshiba Phonebook Setup appears.
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2 Create the new phonebook file.
(1) Double-click on [Add settings file].

A “New settings” file is created. Enter an appropriate name for the new settings file.
(2) To copy the current device phonebook settings to the new settings file, left-click and 

hold on the device phonebook file (e.g.“TOSHIBA”) then drag it to the new settings 
file (e.g. “LA Office Phonebook) and release the left mouse button.

Initially, your mouse pointer will become a “circle with diagonal line”.
Upon reaching the desired phonebook file, the pointer will take the form of an “address 
label”. Upon releasing the left mouse button, the contents of the device phonebook file 
are copied to the new phonebook file.

To save the new settings within TOSHIBA Viewer
go to Step 3.
To save the new phonebook as a file on your local hard disk
go to Step 4.
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3 Save within TOSHIBA Viewer.
Right-click on the new phonebook file and select [Save].

When you click the [Write Settings] button or [Cancel] button to close the screen, 
TOSHIBA Viewer will prompt you to save the file.

4 Save as a file on your hard disk.
(1) Right-click on the new phonebook file and select [Save as....]
(2) The Save settings screen appears. Designate the location on your hard disk and 

enter an appropriate file name, then click on [OK].

The phonebook file is saved as a set file on your hard disk. The file extension is “.set”. 
This file can be retrieved by TOSHIBA Viewer.
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Import CSV-format phonebook
You can import the CSV-format phonebook data into TOSHIBA Viewer.

This function is available only for the e-STUDIO165/205 with the fax option installed.

1 Open the Devices folder.
(1) Select the device and click the [Setup device phonebook] button.

(2) "Reading data from device" appears as Viewer interrogates the attached Multifunc-
tional Digital Systems.
Toshiba Setup appears.

2 Select the phonebook type that you want to import and right-click 
on it then select [Import].
Import Database Wizard appears.
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3 Click [Next].
Choose type of database to import appears.

4 Select the type of database from which you want to import and click 
[Next].
Choose file to import appears.
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5 Enter the file path and file name to File To Import and click [Next].
Mapping fields appears.

You can also click [Browse] to search for the file.

6 Drag the fields from the left side to map them to fields on the right.
First records of the CSV-format data are automatically loaded as the field names and 
they appear in Field column on the left list. Drag the field from the left side and drop it to 
Mapped Field on the right. Mapped field name appears in Mapped Field column.

When both names in two fields are the same, they are automatically mapped.
Clicking [< Previous] or [Next >] displays record value of each field in Example 
Record column on the left list.

7 Click [Next].
Selecting records to import appears.
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8 Select the entries which you want to import.
When you select multiple folder icons, select them with the [Shift] or [Ctrl] key on the 
keyboard pressed.
When you select all the folder icons, click [Select All].

9 Click [Finish].
CSV data record selected is added.

10 Click [Write Settings] to download the data to the e-STUDIO165/205.

Click the [Cancel] button to cancel downloading the data.
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Export phonebook as CSV file
You can export the e-STUDIO165/205 phonebook data as a CSV file into the CSV compatible 
application to edit data. You can also export phonebook data which is saved in TOSHIBA 
Viewer.

This function is available only for the e-STUDIO165/205 with the fax option installed.

1 Open the Devices folder.
(1) Select the device and click the [Setup device phonebook] button.

(2) "Reading data from device" appears as Viewer interrogates the attached Multifunc-
tional Digital Systems.
Toshiba Setup appears.

2 Select the phonebook type that you want to export and right-click 
on it then select [Export].
Export Database Wizard appears.
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3 Click [Next].
Choose type of exported database appears.

4 Click [Next].
Choose format of exported database appears.
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5 Enter the file path and file name to File To Export and click [Finish].
Operation Complete. appears.

You can also click [Browse] to search for the correct folder.
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6 Select whether or not you confirm the exported data.
Click [Yes] to display the exported data.
Click [No] to not display the exported data.

When you click [Yes], the exported data is displayed on the application associated with a 
CSV file.
When you click [No], the operation is completed.

If your Windows system has no application associated with a CSV file, the exported data 
cannot be displayed. However, you can use Windows text editor such as Notepad to 
open and edit the exported data.
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Creating a Routing Rules
When an image is scanned, it is normally stored in the Scanned images folder.
You can change the action by defining one or more Routing rules.

User Routing Rules are:
Created and maintained by any TOSHIBA Viewer user.
Specific to the user.
i. e. Each user can define their own Routing Rules, which act completely independently of all 
other TOSHIBA Viewer user’s Routing Rules.
Processed by the TOSHIBA Viewer user in the order they are shown, from top to bottom.

Some sample rules are supplied with TOSHIBA Viewer. 
To activate them, go to the Routing Rules dialog, select a suitable sample to base your own rule 
on, click [Copy], click [Modify], enter the incomplete information and click [Finish] to store the 
completed rule.

For further details of Routing Rules, click [Help] on the Routing Rules dialog to view related help 
topic.

1 Select [Setup], [Routing Rules...] from the menu.
Click [New...] to create a new rule. Routing Rules Wizard appears.
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2 Check on the terms for a rule.
Click [Next]. Follow the prompts to create a rule.

3 Enter the name of the rule.
Click [Finish].
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4 Click [Move up] to change the apply order.
Click [OK].

For further details of creating and modifying the Routing Rules, see [Help].
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Finding items stored in TOSHIBA Viewer folders
Once files are stored in TOSHIBA Viewer folders, you can ask TOSHIBA Viewer to find items for 
you based on their properties.

In order to search in the specific folder, right click on the specific folder and select Find.

1 Click [Find icon].

2 Define a new search.
Check on [Include subfolders] when you want to search folders in subfolders as well.
Select what properties you want to look for, by checking the boxes corresponding to 
those properties in the Search Criteria list, and complete the details to search for by 
clicking on the red underlined words in the Match a message list.

You can also search folders by selecting the Search history.
Click [OK].
Searching starts.
For further details of searching, click [Help] on the Search dialog to view a related 
help topic.
TOSHIBA Viewer will show you the results of the search; you can right click on 
entries in the Find Results dialog to perform functions on them.

Find icon
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Creating Folder
TOSHIBA Viewer uses folders to store messages that you have scanned, and details about files 
you have on your computer. 
You can then search all or some of these folders to find messages or files at a later date.

1 Select a folder where you want to create a folder in.
Select File - [New - Folder].

2 Type a name for the new folder.
Type a brief comment describing, for example, the folder’s intended use, if required. Click 
[OK].

When you drag from a Windows Explorer to a TOSHIBA Viewer folder, TOSHIBA 
Viewer only stores a reference to the file and document properties for the file.
i.e. The file itself is not copied into the TOSHIBA Viewerfolder and will be 

opened from its original location when you open the reference to it within
TOSHIBA Viewer.

If you drag from a TOSHIBA Viewer folder to another TOSHIBA Viewer folder, 
TOSHIBA Viewer will normally copy the file to the target TOSHIBA Viewer folder.
However if the source references a file outside of the TOSHIBA Viewer folder struc-
ture (i.e. was dragged in from a Windows Explorer folder) only the reference to the 
external file is moved or copied.
If you open an image file (.bmp, .jpg, .tif, .pcx, .fax or .fcs) in the TOSHIBA Viewer 
and then select Save in Unimessage Pro folder from the File menu, the image file 
will always be stored in the TOSHIBA Viewer folder.
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Copy

How to operate "Copy" and each function

Copying with your e-STUDIO163/203/165/205
You can remotely control your e-STUDIO163/203/165/205 to copy the documents.

1 Click Copy on Main Welcome Menu.
Copy pages dialog appears.

2 Enter each attribute for copying.
Enter the number of copies to be copied.
When you want to collate the copies, check on [Collate copies].
Check on [Advanced] if you want to scan different pages with different resolutions or 
double sided documents.
Click on [Change...] to select the printer driver to be used for copying.
For further details of the Copy pages dialog, click [Help] to view a related help topic.

3 Click on [OK] to start copying.
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File Scan

How to operate "File Scan" and each function

Scanning with your e-STUDIO163/203/165/205 or other TWAIN 
compatible scanner
You can use your e-STUDIO163/203/165/205 to scan hard copy documents into any TWAIN 
compatible application you are running.

File Scan also provides a function that allows you to build a multi-page document from several 
separate TWAIN scans.
This is useful if you want to scan different pages with different settings.

You can also operate the scan function from the Main TOSHIBA Viewer Display.
However, you will not be permitted to build a multi-page document.

When you use the other TWAIN compatible applications to scan, the scanner settings dialog 
appears.

1 Click File Scan on Main Welcome Menu.
Click [Select source....] on Scan multiple pages dialog. Select Source dialog appears.

2 Select the TWAIN Scanner.
After selecting the scanner, click [Select]. Back to Scan multiple pages dialog.
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3 Click [Scan].
The scanner setting dialog appears.

4 Set the scanner settings.
After performing the scanner settings, click [Scan]. Back to Scan multiple pages dialog.

For further details of scanner settings, click [Help] to view a related help topic.
Before scanning, you can preview the scanning document by clicking [Preview].
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5 Select the Scanned pages.
After selecting the page, click [Add]. Repeat until all scanned pages are added into a 
document.
If you want to continue scanning
repeat from step 3 to 4.

You can add the scanned pages in desired order to create a multipage document.
For further details of the Scan multiple pages dialog, click [Help] to view a related help 
topic.

6 Click [OK].

7 Select what you do with the scanned images.
After selecting the scan image handling, click [OK].

For further details of the New message received dialog, click [Help] to view a related 
help topic.
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Email Scan

How to operate "Email Scan" and each function

Scanning with your e-STUDIO163/203/165/205 and sending an 
E-mail
You can use your e-STUDIO163/203/165/205 to scan hard copy documents into image file and 
automatically run your default E-mail application and attach the scan file to an E-mail message.

To use the E-mail scan function, the MAPI*1 compatible E-mail application must be installed on 
your PC. 
*1 MAPI, Messaging Application Programming Interface, is a system built into Microsoft Windows to 

enable different E-mail applications to work together.

1 Click E-mail Scan on Main Welcome Menu.

2 Set the scanner settings.
After performing the scanner settings, click [Scan].

For further details of scanner settings, click [Help] to view a related help topic.
Before scanning, you can preview the scanning document by clicking [Preview].
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3 The E-mail application automatically creates a new message that 
the scanned image is attached.
Enter the forwarding address and other information as required.

For further details about sending new message, see the manual or on-line help of the 
E-mail application that you are using.
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Setup

How to operate "Setup" and each function

Changing the Device Configuration
When you click Setup button, the TOSHIBA Viewer starts reading the data from the device and 
displays the TOSHIBA SETUP screen.
This allows you to configure the device settings remotely using the TOSHIBA Viewer.

This can be operated from the Setup button on the Device screen.
For more details about the Device screen, see the following page.

 P.119 “Changing the Device Information”

You can remotely configure the device settings using the TOSHIBA Viewer.
After clicking Setup on the Welcome screen, see the TOSHIBA Viewer retrieves the device set-
tings from the e-STUDIO163/203/165/205.
When you want to change the device settings file directly
go to Step 1.
When you want to change the device settings file by copying the settings from a set file 
located on your hard disk
go to Step 2.
When you want to change the device settings file by copying the settings from a user set-
tings file stored within TOSHIBA Viewer
go to Step 3.

1 Edit the device configuration.
(1) To edit the settings, double click on the item you want to edit and enter the new data.
(2) Click the [Write Settings] button to download the new settings to your 

e-STUDIO163/203/165/205.

Click the [Cancel] button to cancel adding/editing the device configuration.
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2 Load a set file on your hard disk.
(1) Double-click on [Add settings file]. A “New settings” file is created.

(2) Right-click on the new settings file and select [Load....]. The Load settings screen 
appears. Designate the hard disk location of the desired set file, select the file, then 
click on [Open]. The set file is loaded.

In order to create a user settings file to be saved on your hard disk. 
 P.151 “Saving the Device Configuration”

3 Copy the device configuration.
Left-click and hold on the user settings file, then drag it to the device settings file, and 
release the left mouse button.

Initially, your mouse pointer will become a “circle with diagonal line”. Upon reaching the 
device settings file, the pointer will take the form of an “address label”. Upon releasing 
the left mouse button, the contents of the user settings file are copied to the device set-
tings file.
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4 Click the [Write Settings] button to download the new settings to 
your e-STUDIO163/203/165/205.

Click the [Cancel] button to cancel adding/editing the device configuration.
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Saving the Device Configuration
The device setting file opened by TOSHIBA Viewer (default name TOSHIBA) is a temporary 
“working” file.
Every time TOSHIBA Viewer is opened, the program accesses the attached device and reads 
the current settings.
You can store the settings within TOSHIBA Viewer or save them as a file on your hard disk.

This is useful when performing a full memory clear or upgrading the machine’s firmware 
because you can easily re-configure the device by downloading the stored settings.

1 Create the new settings file.
(1) Double-click on [Add settings file]. A “New settings” file is created. Enter an appropri-

ate name for the new settings file.
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(2) To copy the device configuration to the new settings file, left-click and hold on the 
device settings file (e.g. “TOSHIBA”) then drag it to the new settings file (e.g. 
“e-STUDIO163/203 LA Office”) and release the left mouse button.

Initially, your mouse pointer will become a “circle with diagonal line”. Upon reaching the 
desired settings file, the pointer will take the form of an “address label”. Upon releasing 
the left mouse button, the contents of the device settings file are copied to the new set-
tings file.

To save the new settings within the TOSHIBA Viewer
go to Step 2.
To save the new settings as a file on your local hard disk
go to Step 3.
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2 Save within TOSHIBA Viewer.
Right-click on the new settings file and select [Save].

When you click the [Write Setting] button or [Cancel] button to close the screen, 
TOSHIBA Viewer will prompt you to save the file.

3 Save as a file on your hard disk.
(1) Right-click on the new settings file and select [Save as....].
(2) The Save settings screen appears. Designate the location on your hard disk and 

enter an appropriate file name, then click on [Save].

The settings file is saved as a set file on your hard disk. The file extension is “.set”.
This file can be retrieved by TOSHIBA Viewer.
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TOSHIBA Viewer GDI Printer

How to print a document using TOSHIBA Viewer GDI Printer

When the total number of sheets printed with GDI exceeds 250, printing is paused. To clear the 
pause status, press the [START] button on the equipment and click the [OK] button on the 
Viewer prompt dialog box showing “add paper”. The pages remaining will be printed. If copies 
are made before GDI prints 250 sheets or the power is turned OFF and back ON, the counter 
will reset itself.

Printing from TOSHIBA Viewer UniPad
You can print a document using TOSHIBA Viewer GDI Printer, if you have selected to create a 
printer during the installation. 
You can print a document from TOSHIBA Viewer UniPad and other applications.

TOSHIBA Viewer GDI Printer is created as same as the Windows printer drivers in Printers 
folder.
If you have not created, you can also create a TOSHIBA Viewer GDI Printer from the Main 
TOSHIBA Viewer Display.
To create a GDI Printer, see the Help for Create printer.

The TOSHIBA Viewer UniPad is the viewer incorporated into TOSHIBA Viewer. The UniPad 
can view the scanned image.
UniPad is opened.
TOSHIBA Viewer UniPad operates in two modes - Text and Graphical. 
Text mode is used when you create a new message, or after you OCR a scanned image or 
received fax message. 
Graphical mode is used to view received fax messages or image files.
Full information on all of the features of the TOSHIBA Viewer UniPad is available in the help 
file.
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1 Double click a scanned image in the TOSHIBA Viewer main display.
Select [Print] from [File] menu. Continue general operation for printer properties and 
print settings.

2 Select the e-STUDIO163/203/165/205 Printer for Name.
After selecting the e-STUDIO163/203/165/205, click [OK]. The print job is sent to e-
STUDIO163/203/165/205, and the scanned image is printed.
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Printing from Other Application
You can also print a document from other applications using the TOSHIBA Viewer GDI Printer.

The procedure is the example with Windows NotePad.
The procedure may vary depending on the application.

1 Select [Page Setup...] in File menu.
Page Setup dialog appears.

2 Click [Printer...]
Page Setup for Printer dialog appears.
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3 Select e-STUDIO163/203/165/205 Printer for Name.

(1) Click [Properties] for general operation for printer properties. Printer properties dia-
log appears.

(2) After setting printer properties, click [OK].
(3) Click [OK] on Page Setup for Printer dialog. Back to Page Setup dialog.

4 Set print settings.
After performing print settings, click [OK]. Page Setup dialog is closed.
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5 Select Print in File menu.
The print job is sent to e-STUDIO163/203/165/205, and the document is printed.
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